
 

Online Resources: a general guide for YAC leaders 

  
Step 1 is an exploration of a place and its surroundings using modern and historical maps and 

aerial imagery. It offers an opportunity for you learn how to manipulate the information to suit 

your own skill-level and pace, and then pass on what you have learned to YAC members. 

 

This first step is the foundation for all the other steps in this project. It can build on any work 

children may have already done at school (using Digimap for Schools for instance), but in this 

case using other online map resources which will help them to identify and understand history, 

archaeology, and changes which take place over time. The core online resources we 

recommend you to use for this project are: 

 

➢ Resource 1: What do places looks like from the air? - Google Earth; Bing Maps, 

and the National Library of Scotland (NLS) 

 

➢ Resource 2: Getting to know maps - Charles Close Society (CCS), and the Ordnance 

Survey (OS) 

 

➢ Resource 3: Delving into the past with maps - National Library of Scotland (NLS) 

 

These websites provide us with access to view a range of modern and historic maps, as well as 

aerial imagery. You will find that some of the online maps etc. are available on more than one 

site, and the best way to find which one meets your particular need is simply to spend an hour 

or so ‘playing’ with each. It would be almost impossible to provide instructions for every 
permutation of each piece of online software we recommend using. However, for each we have 

provided a summary of technical information and an Introductory Guide to help get you 

started. 

 

 

STEP 1

STEP 2

STEP 3

STEP 4

Find your Place 
 



2 

 

Treat this project as being a process of self-exploration and learning in small steps about how to 

understand a place. These online resources are used regularly by landscape archaeologists. Find 

which combination suits you and your group. We are aiming to raise your awareness of 

possibilities and leave you free to shape ideas for your branch and its members. 

  

We want to ensure that all resources we use are as safe as possible and in addition do not 

infringe on any copyright issues. As the intention of the project is to encourage exploration of 

the world of maps and aerial photographs online there is no requirement to print out copies. 

Most of the sites we will use allow map images to be printed for personal use but please check 

with us if you have any specific needs. 
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Resource 1 

What do places look like from the air? 
  

Google Earth  
A lot of people may already be familiar with Google Earth software. It is a fantastic resource 

and is often used extensively in education and the professional sectors. Google Earth is a mix of 

aerial and satellite photography and some map information. It allows us to take to the air as if 

we were in an aeroplane or a bird, and allows us to explore the landscape. It allows you to 

easily move around and see places that you may never have found otherwise. Many 

archaeologists use Google Earth to discover archaeological sites. For many areas, the aerial 

photography was taken at different dates and so can be used to see how a place has changed 

over time. 

 

For this project use of Google Earth Pro is recommended as this provides a number of facilities 

not available on the web-based version (see below).  

 

 

Technical stuff 
The software can be used in one of three ways, via a web browser, an app on a mobile device, 

or as a standalone application running on a PC (Google Earth Pro).  

 

Downloading and installing Google Earth Pro. This can be done by visiting: 

https://www.google.co.uk/intl/en_uk/earth/versions/ and clicking on the ‘Google Earth Pro on 

Desktop’ button. Please follow the installation instructions as stated on the Google Earth site. 

 

Google Earth Pro is free. As of January 2021, the supported platforms for Google Earth Pro are: 

  

➢ PC - Windows 7 or newer 

➢ Mac - OS X 10.8 or later 

➢ Linux - Ubuntu 14 / Fedora 23 (or equivalent) or newer. 

  

 

There are many good tutorials available on the internet on how to get started with Google 

Earth Pro, just try to make sure you choose a version that is up to date. We recommend you 

use all default options. All data is saved onto your own computer. The online connection is only 

used to download the content you have requested. Getting used to Google Earth’s navigation 
controls can initially be quite tricky, but stick with it, the more you use it, the more natural and 

intuitive it becomes.  

 

Having recommended that Google Earth Pro is downloaded and used as above, it is possible 

that it may be necessary for some to use the online web version instead. Indeed, some may 

want to use both. The online version is still a very useful aid to assist us in finding information 

on our chosen place, but it does not offer all of the features available in Google Earth Pro. The 

https://www.google.co.uk/intl/en_uk/earth/versions/
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web-based version also requires you to log into a Google account to store project information. 

This is perhaps a more ‘playful’ version but Google Earth Pro offers more control of your own 
project on your own computer without need to set up a Google account. 

 

To access the online version of Google Earth, please use the following link: 

http://earth.google.co.uk/ and then click the ‘Launch Earth’ button. Some problems using 

Internet Explorer have been encountered using that link. An alternative link below may resolve 

that problem depending on your local computer configuration. 

https://earth.google.com/web 

 

Copyright: Google’s statement on copyright can be read by following this link: 

https://about.google/brand-resource-center/products-and-services/geo-guidelines/ Essentially 

you can export/print out and annotate a map provided acknowledgement is given. This is 

simple to achieve, just ensure that the Google watermark and details (usually  

available at the bottom of image) is retained in any image you wish to use. 

 

Bing Maps 
This site provides a good mixture of aerial imagery and maps. It is similar to Google Earth 

although does not contain as many features. Its main advantage is that it provides an 

alternative source of aerial imagery to that of Google Earth. It is well worth comparing both 

once you start investigating your site as they may have been taken at different times and dates. 

We suggest that you use Google Earth pro as the main tool and use Bing as a supplementary 

source of information. One important aspect of Bing Maps is that it allows you to view OS 

1:25000 scale maps. 

 

Technical stuff 
Bing Maps can be accessed using the following link 

https://www.bing.com/maps/aerial 

 

Terms for copyright and use of data can be viewed at  

 https://www.microsoft.com/en-us/servicesagreement/ 

 

 

National Library of Scotland (NLS) 
This comprehensive site is covered in more detail in Resource 3 in relation to its map collection. 

However, it does contain various types of aerial imagery such as Bing, ESRI World Image, and 

Lidar. Once you have read the Introductory Guides take a look to see which aerial imagery 

source suits your needs best. Lidar, which is data gathered from aerial laser scanners, is very 

useful for revealing ‘lumps and bumps’ in the ground and is covered in more detail in Step 4. 

 

 

 

http://earth.google.co.uk/
https://earth.google.com/web
https://about.google/brand-resource-center/products-and-services/geo-guidelines/
https://www.bing.com/maps
https://www.bing.com/maps
https://www.microsoft.com/en-us/servicesagreement/
https://www.microsoft.com/en-us/servicesagreement/
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Google Earth Pro  

Introductory Guide 
 

 

 

 

 

Opening screen 

 

• After clicking the desktop icon on 

your computer the Google Earth Pro 

opening screen will look something 

like this.  

 

• Navigation controls are on the top 

right. More control can be gained by 

using a mouse. Find out how each 

works and use which suits you best. 

Use the Help menu to find some 

useful keyboard shortcuts 

 

• Along the top horizontal rows are a 

series of drop-down menus and a 

row of icons for specific tasks.  

 

• On the left side of the screen, a 

column will have three headings in 

blue with an arrow next to each 

Search; Places; Layers   

 

• Clicking the arrow for each will open 

up a drop-down sub-list. 

 

  

Get to know the three main categories in 

the left column 

 

• Search. Type in a placename (eg 

Clifford’s Tower, York) and Search or 

hit enter button on the keyboard. 

The image will move and zoom to 

York. Street names and various 

other places of interest can easily be 

found this way. 

 

• Places. Places you are interested in 

can be stored and displayed using 

Placemarks (see below). 
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• Layers. Expand by clicking the 

arrow. Features which can be 

displayed over the aerial imagery 

are listed. Some can be expanded to 

show further categories of features. 

Tick and untick each to see the 

effect on the imagery. Zoom in and 

out to see the effect at different 

scales. 

 

 

 

 

Seeing things from a different perspective 

 

• For some areas of the British Isles, 

‘bird’s-eye’ 3D views have been 
created so that heights of buildings 

and the mountains, hills and valleys 

can be visualised. To see the effect, 

ensure 3D Buildings and Terrain are 

ticked in Layers and practice moving 

around at different heights and 

perspectives using either the mouse 

or the navigation controls. 

 

• In the navigation controls is a small 

orange human figure. Drag that 

figure down into the frame on a 

road to enter Street View. You can 

then look the place as if you were 

there on the ground. You can move 

around the roads and look around 

by using the navigation controls or 

the mouse. 
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Placemarks 

• These are especially useful 

for recording places and going back 

to them. 

 

• To add a Placemark click the 

pushpin icon or select from the 

Add>Placemark drop-down menus. 

Move the placemark to where you 

want it. 

 

• Information about the Placemark 

can be recorded in a dialogue box. 

You can also record links and 

images as appropriate, as well as 

customise its appearance. Press OK 

when complete. 

 

• If you click on that pushpin later a 

box containing the information will 

pop up at that place.  

 

• If you want to save the Placemark 

and the information right-click with 

your mouse to save. A menu will 

appear. Choose Save Place As. 

Another dialogue box will appear – 

name the file and where you want 

to store it. Save as type KML. It will 

then be added to Places> My 

Places menu in the left column of 

the screen. 

 

• KML is the file extension for an 

unzipped file, while KMZ is the 

zipped version of a KML file.  

 

• The Placemark can be emailed to 

anyone else to load into Google 

Earth and many other programs. 

Select File>Email>Email Placemark 

from the drop-down menus. 
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Polygons 

• The Polygon icon allows you 

to draw on shapes and outlines of 

anything that you might want to 

record. In this case the shape of the 

mound of York’s other castle across 
the river from Clifford’s Tower. 

Move the cross hairs to each point 

and left-click. Each point can be 

moved if you want to change its 

position. You can configure name, 

information colours, lines and 

transparency etc. with the dialogue 

box. Press OK. 

 

• If you want to record the polygon 

and the information right-click with 

your mouse to save. A menu will 

appear. Choose Save Place As. 

Another dialogue box will appear – 

name the file and where you want 

to store it. Save as type KML. It will 

then be added to Places> My Places  

menu in the left column of the 

screen. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Historical imagery 

 

• Aerial Imagery taken at various 

dates is available using this icon. 

Some, dating back as far as 1945, is 

available for the areas of the British 

Isles shown in grey.  

 

 

 

 

 

• At the top left is a slider showing the 

dates the aerial imagery has been 

acquired. Move the slider to see 

what was there (or not there) at the 

various dates. 
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Search the past 

 

• Search for Chester Zoo and put the 

slider back to 1945. 

 

• Where is the zoo? Is there any 

evidence it was there at that date. 

 

• Compare what you see in 1945 

imagery with what you see on the 

2019 imagery below. 

 

 

 

 

  

Where is the elephant in the room? 

  

 

 

 
 

• Can you spot the elephant enclosure 

(clue – look at the shadows). 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

Measuring 

 

• The Ruler icon can be used to 

measure distances and areas. It 

can also be accessed from the 

Tools drop-down menu. 

 

 

• How wide is the Menai Straights 

where the bridge crosses the 

channel? Use Line to measure 

between two points. 
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• Practice by measuring features 

labelled in the tabs in the dialogue 

box.  

 

 
 

 

 

 
 

 

 

 

 

Making a movie 

 

 

• You can record a movie of a journey 

or exploration. In the drop-down 

menu select Tools>Movie Maker 

(tick) 

 

• To see an example of a mp4 movie  

click this link 

 

https://youtu.be/Yn_iJO5xZ0o 

 

• Movie Maker dialogue box will 

appear. You can select to control 

the moves by mouse and keyboard 

from Record from or replay a saved 

movie. 

 

• The movie can be saved in a file or 

folder of your choice on your 

computer. 

 

• Play about with the other settings to 

suit your own needs. 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://youtu.be/Yn_iJO5xZ0o
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Finally 

 

• In the Tools>Options  drop-down 

menu is a dialogue box. This allows 

you to choose various settings to 

suit you, your computer, and your 

needs. You will need to play about a 

bit to see effects. Leave at default if 

what you are doing seems OK. 

 

 

 

It is not possible to cover all eventualities in a short guide such as this. However, if you 

unfamiliar with Google Earth Pro this will get you started. Take time to explore your place 

in different ways. 
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Resource 2 

Getting to know maps 

 

The Charles Close Society (CCS) 

The Charles Close Society is a members’ society which brings together those with an interest 

in the maps and history of the Ordnance Survey of Great Britain and its counterparts in 

Ireland. The Society was founded in 1980 and takes its name from Colonel Sir Charles Arden-

Close, OS Director General from 1911 to 1922. It provides an online portal into a number of 

mapping resources and the Society has kindly given us permission to use their site for this 

project.  

 

Also provided here are links to some really good free Ordnance Survey education guides 

designed for teachers to help children learn some of the basic map skills and help them to 

understand the nature of places. 

 

Technical stuff 
For The Charles Close Society there is no application to download. All that is required is a 

web browser (almost all will work) and an active internet connection. Links to other map 

resources are available through this portal. 

https://www.charlesclosesociety.org 

It is certainly worth taking some time to look around the website, we suggest you start at 

https://www.charlesclosesociety.org/society where the origins and aims of the society can 

be found.  

 

A complete list of their online resources can be found via this link: 

https://www.charlesclosesociety.org/onlinemaps (correct as of January 2021). From here 

you will have access to the latest as well as most historic Ordnance Survey maps. In 

addition, there are links to other map resources for the UK. 

 

The Public Records Office Northern Ireland (PRONI) site can be viewed through the CCS 

website. It is subject to Crown Copyright. The statement can be read here at 

https://www.nidirect.gov.uk/articles/crown-copyright It states “You may use and re-use the 

information featured on this website (not including logos) free of charge in any format or 

medium, under the terms of the Open Government Licence with only a few conditions” 
which can be read on the following link: http://www.nationalarchives.gov.uk/doc/open-

government-licence/version/3/ (correct as of January 2021). 

https://www.charlesclosesociety.org/
https://www.charlesclosesociety.org/society
https://www.charlesclosesociety.org/onlinemaps
https://www.nidirect.gov.uk/articles/crown-copyright
http://www.nationalarchives.gov.uk/doc/open-government-licence/version/3/
http://www.nationalarchives.gov.uk/doc/open-government-licence/version/3/
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While the PRONI site works with most browsers, there are reports that error messages can 

be seen if Internet Explorer 11 is being used. The recommended browsers are: Microsoft 

Edge, Google Chrome, Mozilla Firefox or Safari. 

 

The following page is probably worth reading first: 

https://www.nidirect.gov.uk/services/search-proni-historical-maps-viewer. It walks you 

through the basics of how to use the resource. The site uses widgets for navigation. What 

they mean, and how they can be used are all described via the link above.  

 

In addition, there is a very useful video that is mentioned on the PRONI site that describes 

how to get the best out of the site. It can be viewed by following this link: 

https://www.youtube.com/watch?v=nLSqV0S_-ws  

 

  

https://www.nidirect.gov.uk/services/search-proni-historical-maps-viewer
https://www.youtube.com/watch?v=nLSqV0S_-ws


14 

 

Ordnance Survey  

Introductory Guide 
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 Opening screen 

 

• Follow this link to access the home 

page. 

 

https://www.ordnancesurvey.co.uk/educati

on/teacher-resources 

 

• There are a number of resources 

available on that website which will 

help you work with younger people 

and help them to understand maps.  

 

• Understanding maps is particularly 

useful to take a look at for this 

project. If you expand this menu you 

find a number of guides available for 

free download. Have a look at each. 
 

 

• Of particular interest are 

 

Mapzone which is a fun interactive 

collection of puzzles and quizzes for 

children. 

 

Map Reading made easy 

 

Map reading for beginner to 

advanced 

 

Using the national Grid 

 

The Charles Close Society  

Introductory Guide 
 

https://www.ordnancesurvey.co.uk/education/teacher-resources
https://www.ordnancesurvey.co.uk/education/teacher-resources


16 

 

 

 

 
 

  

 Opening screen 

 

• Follow this link to access the home 

page. 

 

https://www.charlesclosesociety.org 

 

• Click Online Resources in the column 

on the left-hand side of the screen. 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Getting to the maps 

 

• There is a long list of available 

resources with links. If you scroll 

down you will see what the resources 

are and can explore them later.  

 

• Have a look at the Basic Resources 

group. This gives access to mapping 

for the United Kingdom and the 

Republic of Ireland at various scales. 

 

• For England, Scotland and Wales start 

by exploring  Current OS Landranger 

mapping online to get used to 

changing scale. 

 

• Maps for Northern Ireland, Republic 

of Ireland, Isle of Man and Guernsey 

can be viewed using the appropriate 

links in Basic Resources group. (see 

below) Online mapping for Jersey is 

very limited. 

 

• Start by searching for ‘York’ using the 

Current OS Landranger mapping 

online. It will default to the 1:50000 

scale Landranger map but use the 

mouse or the screen controls at the 

top left to see OS maps at smaller and 

larger scales. Practice zooming 

through the various scales to show 

levels of detail each scale of map 

shows for that location. 

 

• As well as finding your own place, 

take a journey across the UK and look 

at places that you have never been to 

or would like to go. 

https://www.charlesclosesociety.org/
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• The dark box in the top right will 

display National Grid References in 

Eastings and Northings (Ordnance 

Survey maps) and Latitude and 

Longitude coordinates. 

 

• See what coverage of each scale and 

type of map provides for your area. 

Coverage and scales vary, especially 

for the Channel Islands. The Guernsey 

site is particularly good, showing 

records for archaeological sites and 

monuments and historic aerial 

photography. 

 

 

• Return to the Online Resources page 

to access mapping for the Republic of 

Ireland, Northern Ireland, Isle of Man 

and Guernsey. 

 

 

• Current Republic of Ireland 

Mapping online 

 

• Dialogue box at the top left allows 

access to different datsets. Open 

Base Information and Mapping 

 

• Various types of aerial imagery, 

modern and historical maps can 

then be viewed in layers. 

Transparency sliders allow you to 

‘see through’ the layers. 

 

 

 

 

 

 

 

  

 

 

 

 

 

• Current Northern Ireland Mapping 

online 

 

• At the opening page select Maps > 

Map Viewer 
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• On the Map Viewer page you will 

find a series of icons along the top of 

the map. Experiment with them to 

view various scales of map and other 

features including aerial imagery 

 

• Use the Map Gallery drop-down 

menu to access the Historical tab. 

This will give you access to Historical 

maps and Historical Environment 

Records. The Layers List icon with 

each will then show a list and dates 

of old maps available to view. Select 

as appropriate. 
 

 

 

 

 

 

 
 

 

 

 

 
 

 

 

 

• Isle of Man mapping online provides 

access to the Isle of Man government 

website. This provides mapping 

showing street level detail. 

 

• Click the Information icon to access a 

list of categories. 

 

• Ordnance Survey mapping up to 

1:50000 scale is available through the 

Current OS Landranger mapping 

online  

 

• Historical Ordnance Survey maps are 

also available through the National 

Library of Scotland website (see 

Resource 3). 

 

 

 

 

 

 

 

 

• Guernsey mapping online 

 

• There are a number of datasets 

available. Experiment and see what 

each contains and how useful it may 

be to you. Probably the most useful 

for this project are likely to be 
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• Environmental 

 

• Geographical 

 

• Antiquities 

 

• Guernsey Historic Maps 

 

• WWII 1945 Aerial Photography 

 

 

 

 

• Return to the Online Resources page. 

Here you will find links to many other 

sources of maps, some of which will 

be referred to in Steps 2-4. In 

particular MAGIC map where 

Ordnance Survey 1:25000 and 

1:10000 mapping can be viewed. OS 

1:25000 mapping can also be viewed 

on the BIng Maps website. 
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Resource 3 

Delving into the past with maps 

 

National Library of Scotland (NLS) 
The National Library of Scotland is an online resource that is not restricted to just those in 

Scotland. It is probably the most comprehensive collection of historical maps related to the 

UK to be found anywhere online. In particular, the historical mapping is an invaluable 

resource for investigating places as they were in the 19th century before intensive, 

urbanisation in the major towns and cities. The NLS site also includes such sources as 

military maps from the First World War. The NLS is one of Europe’s major research libraries 

with around 24 million items.  

Technical stuff 
The website can be found using the following link 

https://maps.nls.uk/ 

Content can be viewed by anyone with a computer and internet access. 

 

A short history and overview of what it is, and what is does can be found here: 

https://www.nls.uk/about-us/what-we-are/nls-history available.  

 

While the site has many categories, the one that we will be using is focussed on maps, and 

more specifically, the ‘Find a place’ page that can be accessed here: 

https://maps.nls.uk/geo/find/ This will launch a browser application where you can select 

your place and then view whatever maps are available for it. 

 

There is a short description on how to use the map resources here: 

https://maps.nls.uk/imagery.html  

 

Copyright: The NLS position on copyright can be read here: https://www.nls.uk/copyright 

While copyright needs to be observed, there are some exceptions which can be viewed at 

https://www.gov.uk/guidance/exceptions-to-copyright This page has a section on Non-

commercial research and Private Study which can be seen here: 

https://www.gov.uk/guidance/exceptions-to-copyright#non-commercial-research-and-

private-study.  

 

 
 

 

 

 

https://maps.nls.uk/
https://www.nls.uk/about-us/what-we-are/nls-history
https://maps.nls.uk/geo/find/
https://maps.nls.uk/imagery.html
https://www.nls.uk/copyright
https://www.gov.uk/guidance/exceptions-to-copyright
https://www.gov.uk/guidance/exceptions-to-copyright#non-commercial-research-and-private-study
https://www.gov.uk/guidance/exceptions-to-copyright#non-commercial-research-and-private-study
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National Library of Scotland 

Introductory Guide 
 

 

 
 

 

 

Accessing the map images 

 

• Follow this link to access the map 

images page. 

 

https://maps.nls.uk/ 

 

• On the left hand side of the 

screen Main Map Categories 

contains a scrolling list of the map 

sources. 

 

• Scroll down to see them all. There 

are 18 in all. 

 

• Many of the categories are 

specifically related to Scotland. 

 

• Ordnance Survey historical maps 

are also available for England and 

Wales. Select Ordnance Survey 

maps and choose map series and 

collection as appropriate. 

 

 

 

 

 

There are Help videos which are useful to 

watch. In particular.  

 

• An Introduction 

 

• Find by place viewer 

 

• Explore georeferenced maps 

 

 

 

 

 

 

 

 

 

 

https://maps.nls.uk/
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• The best category to start with is 

Ordnance Survey maps. 

 

• One of the simplest ways to find a 

map is by using Browse all 

Ordnance Survey maps for a place 

 

 

 

 

 

 

 

 

• Three other ways of finding maps 

are provided by the options at the 

top 

 

• Find by Place 

 

• Explore georeferenced maps 

 

• Side by Side 

 

•  A Help screen usually appears at 

each change of menu and shows 

you how to select the various 

dates of maps which are available 

to view.  

 

 

 

 

 

 
 

 

Find by Place 

 

• Enter a place e.g. York. Places can 

be searched by name or with an 

OS grid reference. 

 

• The area of the historic maps 

available from the various series 

will be highlighted. If for example 

‘OS 25 inch between 1850s-1960s’ 
is selected as the map series, a 

grid of available sheet is shown. If 

one is selected the images of 

various dates are shown on the 

right of the screen. 

 

• Click that image to see the 

historical map in more detail 
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• Experiment with maps scales, 

categories and map series. 

 

• Historical information about the 

date of a map (when it was 

surveyed for instance) will be 

displayed. 

 

• Experiment with various scales, 

historic maps series, and 

background maps to get a better 

idea of what is available. 

 

 

 
 

 

 
 

 

 

 

 

Explore georeferenced maps 

 

 

• The Help screen will get you 

started. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• If you move the Change 

transparency of overlay slider 

you will see the old map over 

aerial imagery. 

 

• At the top right are Measurement 

tools. You can measure distance 

and area using these. 

 

• Map images can also be viewed in 

3D. 
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• The Spy facility allows you to view 

selected georeferenced maps 

through a spyglass viewer. 

 

 

 

 

Side by Side 

 

• A Help screen usually appears at 

each change of menu and shows 

you how to select the various 

dates of maps which are available 

to view. 

 

 

 

 

 

 

 

 

 
 

 

 

• Move the slider in the centre to 

merge one image with another. 

This is very useful for easily 

identifying change over time. 

 

• Categories and map series can be 

changed for each side for 

comparison. 

 

 

 

The NLS is an incredibly powerful tool for finding out how places looked in the early days 

of Ordnance Survey mapping. The maps are a great way of picking out even small changes 

due to the large scale of many of the maps. This website site is a joy in itself for all students 

of mapping.  
 

 


